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Important Information

Except as otherwise expressly stated in the License that accompanies a program, Texas
Instruments makes no warranty, either express or implied, including but not limited to
any implied warranties of merchantability and fitness for a particular purpose,
regarding any programs or book materials and makes such materials available solely
on an "as-is" basis. In no event shall Texas Instruments be liable to anyone for special,
collateral, incidental, or consequential damages in connection with or arising out of the
purchase or use of these materials, and the sole and exclusive liability of Texas
Instruments, regardless of the form of action, shall not exceed the amount set forth in
the license for the program. Moreover, Texas Instruments shall not be liable for any
claim of any kind whatsoever against the use of these materials by any other party.

Learning More with the Tl-Innovator™ eGuide

Parts of this document refer you to the Tl-Innovator™ eGuide for more details. The
eGuide is a Web-based source of TI-Innovator™ information, including:

e Programming with the TI-84 Plus CE Graphing Calculator and
TI-Nspire™ Technology, including sample programs.

e Available I/O Modules and their commands.
e Available breadboard components and their commands.

* Free classroom activities for Tl-Innovator™ Hub.

To access the eGuide, visit the Web address shown below, or use your mobile device to
scan the corresponding QR Code®.

https://education.ti.com/go/eguide/hub/EN

Apple®, Chrome®, Excel®, Google®, Firefox®, Internet Explorer®, Mac®, Microsoft®,
Mozilla®, Safari®, and Windows® are registered trademarks of their respective owners.

QR Code® is a registered trademark of DENSO WAVE INCORPORATED.
Select images were created with Fritzing.

© 2011 - 2016 Texas Instruments Incorporated
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TI-Innovator™ System Overview

The Tl-Innovator™ System consists of Tl-Innovator™ Hub with Tl LaunchPad™
Technology, and optional TI-Innovator™ components.

The Tl-Innovator™ Hub lets you use your compatible Tl graphing calculator or
TI-Nspire™ CX computer software to control components, read sensors, and create
powerful learning experiences.

* You communicate with the Hub through Tl Basic programming commands. Hosts
that are compatible with Tl-Innovator™ Hub include:
- TI-84 Plus CE Graphing Calculator
- TI-Nspire™ CX or TI-Nspire™ CX CAS handhelds
- TI-Nspire™ CX or TI-Nspire™ CX CAS computer software.

¢ TlHnnovator™ Hub. Communicates with the host, the Hub on-board components,
and connected external components. It also distributes power to external
components.

¢ Tl-nnovator™ Components. These components, sold separately, include sensors,
motors, and LEDs that connect to the Hub through its I/O ports and breadboard
connector.

Learn More

For a list of precautions to take while using the Hub and its components, refer to
General Precautions (page 31).

To find information on accessories, external modules, and breadboard components,
visit education.ti.com/go/innovator.
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What's in the Box
Tl-Innovator™ Hub with On-Board Components

@ A Light Brightness Sensor at the bottom of
the Hub can be read as "BRIGHTNESS" in
Hub command strings.

@ Red LED is addressable as "LIGHT" in Hub
command strings.

@ Speaker (at back of Hub, not shown) is
addressable as "SOUND" in Hub command
strings.

@O Red-Green-Blue LED is addressable as
"COLOR" in Hub command strings.

Also visible on the face of the Hub are a green
power LED, a green auxiliary power LED, and a
red error LED.

Built-in Ports

Left side - Three ports for collecting data or
status from input modules:

e IN1andIN 2 provide 3.3V power
e IN 3 provides 5V power

sV_IN3 IN2 IN1 j3av

Right side - Three ports for controlling output
modules:

e OUT 1 and OUT 2 provide 3.3V power.
e OUT 3 provides 5V power.

33vqOUT1  OUT2; |OUT3ysv

Bottom - Light Brightness Sensor (described

earlier) and two ports:

e 12C port connects to peripherals that use the
12C communication protocol.

e DATA Mini-B port, used with the appropriate
cable, connects to a compatible graphing
calculator or computer for data and power.

BRIGHTNESS 12C




Top - Two connectors:

e USB-Micro connector (PWR) for auxiliary
power required by some components. Also
used for updating the Hub internal software
(page 28).

e Breadboard Connector with 20 labeled pins i
for communication with connected PWR 15345678810
components. A breadboard and jumper
cables are included with the Tl-Innovator™
Breadboard Pack, sold separately.

USB Cables

@ USB Unit-to-Unit (Mini-A to Mini-B) - Connects the Hub to a TI-84 Plus CE Graphing
Calculator or a TI-Nspire™ CX Handheld.

@ USB Standard A to Mini-B - Connects the Hub to a computer running
TI-Nspire™ CX Software.

© USB Standard A to Micro - Connects the PWR port of the Hub to a Tl approved
power source required by some peripherals.

Auxiliary Power

TI Wall Charger - Supplies power through the

Tl-Innovator™ Hub for components, such as motors, that
require additional power.

The optional External Battery can also provide auxiliary power.

Note: An auxiliary power LED on the Hub indicates when the
Hub is receiving auxiliary power.




System Requirements

You can use any of the following Tl graphing calculators or computer software to
communicate with TI-Innovator™ Hub.
Calculator or Software

e TI-84 Plus CE Graphing Calculator with operating system version 5.2 or later
installed. You also need to install or update the Hub App, which contains the Hub
menu. See the Hub App instructions below.

e TI-Nspire™ CX or TI-Nspire™ CX CAS handheld with operating system version 4.3 or
later installed.

e TI-Nspire™ computer software version 4.3 or later.

Web Browser

A browser is required for updating the TI-Innovator™ Sketch (the internal software of
the Hub).

e Firefox®: Version 30 or later
e Chrome®: Version 40 or later
e Safari®: Version 7 or later

e Internet Explorer®: Version 11 or later
Installing the Hub App on TI-84 Plus CE Graphing Calculators

All TI-84 Plus CE Graphing Calculators running Operating System v5.2 can use
TI-Innovator™ Hub commands. However, the Hub Menu for OS v5.2 resides in a
separate Hub App.

To Download the App:

Note: This procedure applies only to TI-84 Plus CE Operating System v5.2 users who
need to install or update the Hub App. To determine your calculator's OS version, press
(2nd] [mem] and select About. To determine if the Hub App is already installed, press
(2nd] [mem], select Mem Management/Delete, select Apps, and look for "Hub" in the list
of installed Apps.

1. Make sure you have installed version 5.2 or later of the TI Connect™ CE Software on
your computer. You can download and install it free of charge.

2. Use your Web browser to go to education.ti.com/go/download.

Select your preferred country and language.

4. On the download screen, select TI-84 Plus CE, select Utility Apps, and then click
Find.
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Technology: | TI-84 Plus CE E
View: | Utility Apps v

| Find

A list of Apps appears.

5. Click TI-lnnovator™ Hub App to start the download process. Note the name of the
download file and the folder where you save it.

To Install or Update the App:

1. Connect the calculator to the computer, using the USB Standard A to Mini-B cable.

2. Open the TI Connect™ CE software on the computer. It should recognize the
calculator.

3. On the Actions menu, select Add Files from Computer. You are prompted to choose
a file.

4. Navigate to the folder where you saved the App file, type *.8ek into the File name
field, and press enter to show App files only.

Double-click the Hub App file that you downloaded.

6. On the Send to Calculator screen, Click Send.




Connecting TI-Innovator™ Hub

The Tl-Innovator™ Hub connects by a USB cable to a graphing calculator or computer.
The connection lets the Hub receive power and exchange data with the host.

Note: Some peripherals, such as motors, may require auxiliary power. For more
information, see Using an Auxiliary Power Source (page 26).

Connecting to a Graphing Calculator

1. Identify the "B" connector on the USB Unit-to-Unit
(Mini-A to Mini-B) cable. Each end of this cable is
embossed with a letter.

2. Insert the "B" connector into the DATA port at the
bottom of the Tl-Innovator™ Hub.

3. Insert the free end of the cable (the "A" connector) into the USB port on the
calculator.

'CHOOSE YOUR COLOR"
YR o

1CK A NUMBER"

Hub connected to TI-84 Plus CE Hub connected to TI-Nspire™ CX Handheld
Graphing Calculator




4. Turn on the calculator if it is not already on.

The power LED on the Hub glows green to show that it is receiving power.
Connecting to a Computer Running TI-Nspire™ CX Software

1. Identify the "B" connector on
the USB Standard A to Mini-B
cable for Windows®/Mac®.
Each end of this cable is
embossed with a letter.

2. Insert the "B" connector into
the DATA port at the bottom
of the Tl-Innovator™ Hub.

3. Insert the free end of the
cable (the "A" connector) into
a USB port on the computer.

The power LED on the Hub
glows green to show that it is
receiving power.
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Hub Programming on TI-84 Plus CE Graphing Calculator

Note: These instructions apply to TI-84 Plus CE graphingcalculators. For similar
instructions for TI-Nspire™ CX technology, refer to Hub Programming on TI-Nspire™ CX
Technology (page 16).

The Tl-Innovator™ Hub responds to Tl Basic programming commands such as Send and
Get.

¢ Send - Sends command strings to the Hub to control devices or request
information.

e Get - Retrieves information requested from the Hub.

e eval - Supplies the result of an expression as a character string. Especially useful
within the Hub command string in Send commands.

* Wait - Pauses program execution for a specified number of seconds.

Code Examples: TI-84 Plus CE Graphing Calculator

Desired Action Program Code

Turn on the on-board Red LED Send("SET LIGHT ON")
("LIGHT").

Play a 440Hz tone on the on-board Send("SET SOUND 440 TIME 2")

speaker ("SOUND") for 2 seconds.

Turn on blue element of on-board RGB Send("SET COLOR.BLUE 255")
LED ("COLOR") at 100% brightness.

Read and display the current value of Send("READ BRIGHTNESS")
the on-board light sensor Get(A):Disp A
("BRIGHTNESS"). Range is 0% to 100%.

Sample Program to Blink an On-Board LED

The following TI-84 Plus CE program uses the Send and Wait commands to blink the
on-board red LED in the Hub. The commands are contained in a "For...End" loop that
repeats the ON/OFF blink cycle for 10 iterations.

11



T84 Plus CE
PRGM: BLINK T
FOI"(N, 1, 10) ?Sﬁﬁ?ﬁ'ﬁ{-sﬂgm oN ")
Send("SET LIGHT ON") iﬁﬁ:(;szr LIGHT OFF *)
Wait 1
Send("SET LIGHT OFF")
Wait 1
End

How to Create and Execute a Program

Note: These are abbreviated instructions. For detailed instructions on creating and
executing programs, refer to TI-Basic Programming for the TI-84 Plus CE Graphing
Calculator. The guide is available through the Tl-Innovator™ eGuide (page 2).

Before You Begin

» Refer to System Requirements (page 7), and update your calculator's OS
(Operating System) and Hub App, as needed. You can update from Tl Connect™ CE
software or from another updated calculator.

To Create a New Program on TI-84 Plus CE Graphing Calculator:

1. Onthe Home Screen, press [prgm], select New, and press [enter].
2. Type a name for your program, such as "SOUNDTST," and then press [enter].

The Program Editor opens, displaying a template for your program code.

3. Enter the lines of code that make up your program.

- You must use the Hub Menu to enter TI-Basic commands, such as Send and
Get. (Press and select Hub.)

- You can enter Hub command strings and parameters such as
"SET LIGHT ON" by using the menu or by typing. If you type the strings,
make sure to use the correct case.

- At the end of each line, press [enter]. Each new line is automatically preceded by
a colon (:).

- Use the arrow keys to move through a program. Press to delete, or press

[ins] to insert.
To Close the Program Editor
» Press [quit] to return to the Home Screen.
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The program remains available through the key.
To Run the Program:

1. Ensure that the TI-Innovator™ Hub is connected to your calculator.

2. Ensure that any needed I/O Modules or Breadboard components are connected to
the Hub.

3. From the Home Screen, press [pram], select your program name from the displayed
list, and press [enter],

The program name is pasted to the Home Screen.
4. Press again to run the program.
To Edit an Existing Program:
1. Onthe Home Screen, press [prgm], select Edit.
2. Select the program name from the displayed list, and press [enter].

The program opens in the Program Editor.
Using the Hub Menu to Build Commands

The Hub menu is available on the TI-84 Plus CE calculator anytime you are creating or
editing a program. It can save you time building commands and help you with correct
command spelling and syntax.

Note: To build a command from the Hub menu, you need to know:

e The unique name of the component that you are addressing, such as "SOUND" for
the on-board speaker.

e The command parameters that apply to the component, such as sound frequency
and duration. Some parameters are optional, and you might need to know the
value range of a parameter.

Example of Using the Hub Menu:

This TI-84 Plus CE example builds the command Send ("SET SOUND 440 TIME 2") to
sound a 440Hz tone for 2 seconds on the on-board speaker.

NORMAL FLOAT AUTO REAL RADIAN MP n

PROGRAM: SOUNDTST
:Send("SET SOUND 44@ TIME
2")

1. Open (or create) the program that you will use to communicate with the Hub.

13



2.
3.

9.

Position the cursor where you want to place the command.

The Hub menu appears. CTL I~0 COLOR EXEC
MASend("SET...
2:Send("RERD...
3:Settings..
4:Hait
5:Get(
6:eval(
7
8
9

:Send("CONNECT-0utput..
:Send("CONNECT-InPut...

VPorts..

Select Send "SET and press [enter], and PROGRAM: SOUNDTST

then select SOUND and press [enter]. :Send("SET SOUND R

Type 440 as the sound frequency. PROGRAM: SOUNDTST
:Send("SET SOUND 4401

On the Hub menu, select Settings > PROGRAM: SOUNDTST

TIME. :Send("SET SOUND 44@ TIME
[ |

Type 2 as the TIME value. PROGRAM: SOUNDTST
:Send("SET SOUND 440 TIME
|

To complete the command, type closing PROGRAM: SOUNDTST

quotes (press (#]), and then :Send("SET SOUND 448 TIME

press [0]. 2"

To return to the Home Screen and test the command, press [quit] and then
follow the previous instructions for running a program.

Tips for Coding with TI-84 Plus CE Graphing Calculator

Make sure your code is free of unnecessary spaces that can cause syntax errors.
This includes repeated spaces within the line and one or more spaces at the end of
a line.

Code from an external source might show "curly" quotation marks (“...”) in places
that require straight quotes ("..."). To type straight quotes, press and then [+].

To clear the current line of code, press [clear].

To type relational operators such as =, <, and <, press [test].

To type a space, press and then [0].

If your program becomes unresponsive while running, press the key.

Note: If a command syntax does not include an opening left parenthesis, such as
Wait , using a pair of parentheses in an argument may be interpreted as the full
argument and given unexpected syntax error. When entering long expressions with
parentheses, enclose the entire expression with paired parentheses to avoid syntax
errors of this nature.
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Valid: Wait ((X+4)*5)
Valid: Wait X+4*5
Syntax Error: Wait (X+4)*5

Learn More

To find sample programs, classroom coding activities, and details about programming
the Tl-Innovator™ Hub, see the TI-Innovator™ eGuide (page 2).
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Hub Programming on TI-Nspire™ CX Technology

Note: These instructions apply to TI-Nspire™ CX technology. For similar instructions for
TI-84 Plus CE calculators, refer to Hub Programming on TI-84 Plus CE Graphing
Calculator (page 11).

The Tl-Innovator™ Hub responds to Tl Basic programming commands such as Send and
Get.

¢ Send - Sends command strings to the Hub to control devices or request
information.

e Get and GetStr - Retrieve information requested from the Hub.

e eval() - Supplies the result of an expression as a character string. Valid only within
Send, Get, and GetStr commands.

* Wait - Pauses program execution for a specified number of seconds.

Code Examples: TI-Nspire™ CX Technology

Desired Action Program Code

Turn on the on-board Red LED Send "SET LIGHT ON"
("LIGHT").

Play a 440Hz tone on the on-board Send "SET SOUND 440 TIME 2"

speaker ("SOUND") for 2 seconds.

Turn on blue element of on-board RGB Send "SET COLOR.BLUE 255"
LED ("COLOR") at 100% brightness.

Read and display the current value of Send "READ BRIGHTNESS"
the on-board light sensor Get a: Disp a
("BRIGHTNESS"). Range is 0% to 100%.

Sample Program to Blink an On-Board LED

The following TI-Nspire™ CX program uses the Send and Wait commands to blink the
on-board red LED in the Hub. The commands are contained in a "For...EndFor" loop that
repeats the ON/OFF blink cycle for 10 iterations.
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Define blink()=

Prgm

For n,1,10
Send "SET LIGHT ON"
Wait 1
Send "SET LIGHT OFF"
Wait 1

EndFor

EndPrgm

TI-1spire cx

How to Create and Execute a Program

Note: These are abbreviated instructions. For detailed instructions, refer to the
TI-Nspire™ CX Program Editor, accessible through the TI-Innovator™ eGuide (page 2).

Before You Begin:
» Refer to System Requirements (page 7), and update your software as needed.

- OnTI-Nspire™ CX handhelds, use TI-Nspire™ computer software to update the
Operating System.

- On computers running TI-Nspire™ CX software, use the Help menu to update
the software.

To Create a New Program in a TI-Nspire CX Document:
1. On the handheld, press and select Insert > Program Editor > New.
From the computer software, click Insert > Program Editor > New.

2. Type a name for your program, such as "soundtst," select Program as the Type, and
then click OK.

The Program Editor opens, displaying a template for your program code.

3. Between the Prgm and EndPrgm lines, type the lines of code that make up your
program.

- You can either type command names or insert them from the Program Editor
menu.

- After typing each line, press Enter to type additional code.

- Use the arrow keys to scroll through the program.
To Store the Program:

You must store your program before you can run it.

17



>

On the Program Editor menu, click Check Syntax & Store > Check Syntax & Store.

On the handheld, press and select Check Syntax & Store > Check Syntax &
Store.

To Close the Program Editor

>

On the Program Editor menu, click Actions > Close.
On the handheld, press and select Actions > Close.

If you have made changes since storing the program, you are prompted to Check
Syntax & Store.

To Run the Program:

Ensure that the TI-Innovator™ Hub is connected to your handheld or computer.

Ensure that any needed I/O Modules or Breadboard components are connected to
the Hub.

Open the document that contains the program.

On a Calculator page, type the program name and parentheses. If the program
requires arguments, enclose them in the parentheses, separated by commas.

The program runs.

To Edit an Existing Program:

If necessary, open the document that contains the program.
Go to a Calculator page.

On the Calculator menu, click Functions & Programs > Program Editor > Open.
On the handheld, press and select Functions & Programs > Program Editor >
Open.

Select the program name name from the displayed list.

The program appears in a Program Editor page.

Using the Hub Menu to Build Commands

The Hub menu is available on the TI-Nspire™ CX technology anytime you are creating or
editing a program. It can save you time building commands and help you with correct
command spelling and syntax.

Note: To build a command from the Hub menu, you need to know:

The unique name of the component that you are addressing, such as "SOUND" for
the on-board speaker.

The command parameters that apply to the component, such as sound frequency
and duration. Some parameters are optional, and you might need to know the
value range of a parameter.
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Example of Using the Hub Menu:

This TI-Nspire™ CX example builds the command Send "SET SOUND 440 TIME 2" to
sound a 440Hz tone for 2 seconds on the on-board speaker.

1.1 R
* soundtst on
Define soundtst()=
Prgm
Send "SET SOUND 440 TIME 2"
EndPrgm

Open (or create) the program that you will use to communicate with the Hub.

2. Position the cursor where you want to place the command.

3. Inthe Program Editor menu, select Hub. TIER Actm
. 1: Send "SET 4
On the handheld, press and select ‘fg ngif: T N
Hub. It. 4 Contro|3: Settings 4
@ 5: Transfgd: Wait
L6 /O 5 Get
12 7: Mode |67 evall
=g Hub |7 Send "CONNECT-Output 4
8: Send "CONNECT-Input »
9: Ports 4
A Send "RANGE »

-

The Hub menu appears.

4. Select Send "SET, and then select Define soundtst()=
SOUND to insert the first part of the Prem
command. Send "SET SOUND |'
EndPrgm
5. Type 440 as the frequency value. |59nd "SET SOUND 440]" |
6. On the Hub menu, select Settings > |Send "SET SOUND 440 TIME " |
TIME.
7. To complete the command, Type 2 as Define soundtst()=
the TIME value. Prgm
Send "SET SOUND 440 TIME 2"
EndPrgm

8. To test the command, follow the previous instructions for running a program.
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Tips for Coding with TI-Nspire™ CX Technology

e Code from an external source might contain "curly" quotation marks (“...”) in
places that require straight quotes ("..."). To type straight quotes, press [ctr] [x].

» Toclear the current line of code, press [ctr] clear .
* To type relational operators such as =, <, and <, press =)

e Totype a space, press [ .

e If your program becomes unresponsive while running:

TI-Nspire™ CX Handheld: Hold down the key and press repeatedly.
Windows®: Hold down the F12 key and press Enter repeatedly.
Mac®: Hold down the F5 key and press Enter repeatedly.

Learn More

To find sample programs, classroom coding activities, and details about programming
the Tl-Innovator™ Hub, see the TI-Innovator™ eGuide (page 2).
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TI-Innovator™ 1/0 Modules

These Input/Output modules (purchased separately) include cables for connecting the
modules to the Tl-Innovator™ Hub.

Module  Ports

Image

Sample code for TI-84 Plus CE Graphing
Calculator

White ouT
LED 1
(See note OUT
below)

~—

Turn on the White LED module connected to
OuUT 1:

Send("CONNECT LED 1 TO OUT 1")
Send("SET LED 1 ON")

ouT
3
Servo ouTt Rotate the shaft of the Servo Motor
Motor 3 connected to OUT 3 counter clockwise by
(See note 90°:
below) Send("CONNECT SERVO 1 TO OUT 3")
Send("SET SERVO 1 TO -90")
Equivalent code using a variable with eval():
angdeg:=-90
Send("CONNECT SERVO 1 TO OUT 3")
Send("SET SERVO 1 TO eval(angdeg)")
Analog IN1 2 Read and display ambient light level from the
Light IN2 e : sensor connected to IN 2:
- D
Sensor  IN3 & I Send("CONNECT LIGHTLEVEL 1 TO IN2")
* Send("READ LIGHTLEVEL 1")
¥ Get(L):Disp(L)
Ultrasoni IN1 = Read and display measured distance from the

c Ranger IN2
IN3

ranger connected to IN 3:
Send("CONNECT RANGER 1 TO IN3")
Send("READ RANGER 1")
Get(R):Disp(R)

Vibration OUT
Motor 1

Turn on the Vibration Motor connected to
OuUT 1:

Send("CONNECT ANALOG.OUT 1 TO OUT
2")

Send("SET ANALOG.OUT 1 TO ON")

Note: The White LED module requires some assembly. The Servo Motor requires
auxiliary power and some assembly. For details, refer to the Tl-Innovator™ eGuide

(page 2).

Connecting an I/O Module

You use the 1/0 cable included with the module to connect it to a Hub Input or Output

port.
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1. Check the above table to ensure that you know which 1/0 ports support the module
that you are connecting.

2. Connect either end of the I/O cable to the white connector on the module.

3. (pic of any module with I/O cable attached)

4. Connect the free end of the 1/0 cable to the Hub port you have decided to use.
5

If the module requires auxiliary power, connect the power source (page 26),
Sample Program to Blink an LED Module

The following TI-84 Plus CE program uses Send and Wait commands to blink an LED
module connected to an I/O port.

Note: This program operates correctly only if the calculator is connected to the Hub and
an LED module is physically connected to port OUT 1.

statplot 11 toiset 12 format 13 calc 14 table {5

PRGM: BLINKIO
Send("CONNECT LED 1 TO
ouT1")

For(N,1,10)

Send("SET LED 1 ON")
Wait 1

Send("SET LED 1 OFF")
Wait 1

End

Send("DISCONNECT LED 1")

Note: If you are using

TI-Nspire™ CX technology, omit
the parentheses, and change End
to EndFor.

The Hub command string "CONNECT LED 1 TO OUT1" tells the Hub that an LED module
is connected to port OUT 1 on the Hub. After sending this command, the code can
address the LED as "LED 1." The CONNECT command is required only for /O Modules
and Breadboard components. It is not necessary with the on-board components such as
the built-in speaker.

Learn More

For a list of precautions to take while using the I/0 Modules, refer to General
Precautions (page 31).

To find sample programs, classroom coding activities, a list of additional I/0O Modules,
and details about programming I/O Modules, see the Tl-Innovator™ eGuide (page 2).
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TI-Innovator™ Breadboard Pack

The breadboard and its components (purchased separately) let you build breadboard
projects and connect them to the Tl-Innovator™ Hub through its Breadboard Connector
pins.

The breadboard components include:

e A breadboard and jumper cables for creating electrical connections.

e Addressable components, such as LEDs and sensors, that respond to Hub
commands. These are listed in the table below.

e Passive components, such as resistors, capacitors, and manual switches that are
not directly addressable by the Hub but are required in many breadboard projects.

e A Battery Holder that holds four AA batteries. Batteries are not included.

Addressable Components

Component Image Description

Red LEDs , Light-emitting diode that emits light when
Green LEDs - current passes through it.

RGB (Red-Green- Light-emitting diode with independently
Blue) LEDs adjustable red, green and blue elements. Can

produce a wide variety of colors.

Thermistor v Resistor whose resistance changes based on
temperature. Used for measurement and
control.

7-segment Array of LEDs arranged to display numbers and

Display some alphabetic characters. Also has an LED for

$-430 10 a decimal point.

I
S3Th41L gy, i

Small DC Motor Motor that converts direct current electrical

power into mechanical power.
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TTL Power _ Transistor used for amplifying or switching
MOSFET electronic signals.

TI Analog ’ Sensor that reports a voltage proportional to

Temperature the ambient temperature within a range of
Sensor -55°C to 130°C.

Visible Light ) Sensor that reports the level of ambient light.
Sensor

Infrared Side emitting Infrared LED, designed to be
Transmitter paired with the LTR-301 Photo-Transistor.
LTE-302, -«

yellow dot

Infrared Side sensing Infrared photo transistor, designed
Receiver to be paired with the LTE-302 Infrared Emitter.
LTR-301,

red dot

Sample Code to Blink a Breadboard LED

The following TI-84 Plus CE program uses Send and Wait commands to blink a specific
LED on the breadboard.

Note: This program operates correctly only if the calculator is connected to the Hub and
the LED is physically connected to BB1 (breadboard pin 1) on the Hub.

PRGM: BLINKBB

Send("CONNECT LED 1 TO BB1")
For(N,1,10)

Send("SET LED 1 ON")

Wait 1

Send("SET LED 1 OFF")

Wait 1

End

Send("DISCONNECT LED 1")

Note: If you are using

TI-Nspire™ CX technology, omit
the parentheses, and change End
to EndFor.

BRIGHTNESS  I°C.
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The Hub command string "CONNECT LED 1 TO BB1" tells the Hub that an LED on the
breadboard is connected to pin 1 on the Hub. After sending this command, your code
can address the LED as "LED 1." The CONNECT command is required only for 1/0
Modules and breadboard components. It does not apply to on-board components such
as the built-in speaker.

Breadboard Basics

The breadboard makes it easy to connect the electronic components of a project by
inserting component leads and jumper cables into pins on the breadboard.

The pins are arranged in groups of 5. The 5 pins in each group are electrically
connected to each other at the back of the board. You connect leads and cables
together by inserting them into pins within the same group.

e Power rails at the top and bottom are marked with red (+) and blue (-) stripes. The
groups in each rail are electrically connected along the entire length of the stripe.

e The remaining 5-pin groups on the board are labeled with numbers and letters.
Each group is electrically isolated from the others.

Front of board showing power rails and connection  Interconnections at back of board (normally

pins hidden). The 5-pin groups in each power rail are
interconnected. All other 5-pin groups are
isolated.

The gap at the center of the breadboard allows easy connection of electronic
components provided as dual-inline packages.

You use jumper cables between the Hub and the breadboard to power breadboard
components and to control or monitor them through program code. The Hub has 20
labeled pins, including 10 signal pins, 8 ground pins, one 3.3V power pin, and one 5.0V
power pin.

Learn More

For a list of precautions to take while using the breadboard and its components, refer
to General Precautions (page 31).

To find sample programs, classroom coding activities, and details about programming
breadboard components on the Tl-Innovator™ Hub, see the TI-Innovator™ eGuide (page
2).
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Using an Auxiliary Power Source

Normally, the Tl-Innovator™ Hub and its connected components draw power from the
host calculator or computer, through the DATA connector. Certain components, such as
the optional Servo Motor, require more power than a calculator can provide reliably.

The PWR connector on the Hub lets you connect an auxiliary power source. You can use
the Tl Wall Charger or the External Battery.

TI Wall Charger (included with the Hub)
e  Plugsinto a wall outlet.
e Does not use batteries.

External Battery (sold separately)
e Rechargeable.

e Has On/Off button with a row of LEDs that
momentarily indicate the battery charge
when you turn the battery on.

e Turns itself off after being disconnected
from the Hub for about 3 minutes.

Note: To recharge the External Battery,
disconnect it from the Hub and then connect
it to the TI Wall Charger using the USB
Standard A to Micro cable. Do not use the
External Battery as an auxiliary power source
while it is being charged.

Connecting the Power Source

1. Identify the Micro connector on the
USB Standard A to Micro auxiliary
power cable.

2. Insert the Micro connector into the
PWR connector at the top of the Hub.
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Insert the free end of the cable (the "A" connector) into the USB port on the power
source.

Turn on the power source:
- If using the TI Wall Charger, plug it into a wall socket.

- If using the External Battery, press the power button.

An auxiliary power LED on the Hub glows to show that the Hub is receiving auxiliary
power.

Connect the Tl-Innovator™ Hub to the host calculator, using the USB Standard A to
Mini-B cable.

Connect the I/O Module or breadboard component to the Hub.
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Updating the Hub Software

The Tl-Innovator™ Hub contains software, TI-Innovator™ Sketch, that interprets Hub
commands and communicates with on-board devices and connected modules. A Web-
based tool lets you update the Sketch. Updated versions contain bug fixes and ensure
that your Tl-Innovator™ Hub can communicate with the latest components.

What You Need
e The USB Standard A to Micro cable included with the TI-Innovator™ Hub

e Aninternet-connected Windows® or Mac® computer

* One of the Web browsers listed in the System Requirements for updating the Hub
software

Updating

1. Identify the Micro connector on the
USB Standard A to Micro cable.

2. Insert the Micro connector into the
PWR port at the top of the
Tl-Innovator™ Hub.

3. Insert the free end of the cable (the
"A" connector) into the USB port on
the computer.

A green LED on the Hub shows that the
Hub is receiving power.

4. Direct the computer's Web browser to the following site:
https://education.ti.com/go/eguide/hub

5. Click Hub Software Update.

6. Read the instructions on the Update page, and then click Download.
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A progress bar tracks the installation process. You are notified when the
installation has completed.
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Troubleshooting

I don't see the green LED when I connect TI-Innovator™ Hub.

Make sure that the calculator is turned on.

If you are using a USB Unit-to-Unit (Mini-A to Mini-B) cable to connect to a
calculator, make sure to connect the "B" end of the cable to the DATA connector at
the bottom of the Hub. Reversing this cable prevents the Hub from receiving
power.

Make sure your calculator or computer meets the System Requirements (page 7).

How do I turn the Hub off?

1.

2.

Turn off the host calculator or computer.
—OR -
Disconnect the USB cable.

Disconnect any auxiliary power source connected to the PWR port on the Hub.

Why does my program give me a syntax error?

If you have pasted code from an external source or text editor, it might contain
"curly" quotation marks (“...””) in places that require straight quotes ("..."). You
may need to replace some or all of the curly quotes.

The syntax rules are slightly different between the TI-84 Plus CE calculator and
TI-Nspire™ CX technology. Code originally created for one platform may need to be
modified to work on the other.

On the TI-84 Plus CE calculator, make sure you don't have a space character at the
end of a line of code. To find these trailing spaces in a line, move the cursor to the
line and press []. Adjacent spaces in code can also cause a syntax error.

How do I stop a program that becomes unresponsive?

TI-84 Plus CE calculator: Press the key.
TI-Nspire™ CX Handheld: Hold down the key and press repeatedly.

Windows®: Hold down the F12 key and press Enter repeatedly.
Mac®: Hold down the F5 key and press Enter repeatedly.

Why do | get an error when | try to update the TI-Innovator™ Sketch?

For sketch updating, make sure you are using the USB Standard A to Micro cable,
not the USB Standard A to Mini-B cable. Connect the micro end of the cable to the
PWR connector at the top of the Hub.

Make sure you are using one of the Web browsers required for updating. See
System Requirements (page 7).

Learn More

To find more troubleshooting information, see the TI-Innovator™ eGuide (page 2).
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General Precautions

Tl-Innovator™ Hub

Do not expose the Hub to temperatures above 140°F (60°C).
Do not disassemble or mistreat the Hub.

Do not chain together multiple Hubs through the 1/0 ports or the Breadboard
Connector.

Use only the USB cables provided with the Hub.

Use only the TI provided power supplies:

- Tl Wall Charger included with the TI-Innovator™ Hub

- Optional External Battery

- 4AA battery holder included in the Tl-Innovator™ Breadboard Pack

Ensure that the components receiving power from the Hub do not exceed the Hub's
1-amp power limit.

Avoid using the Hub to control AC electricity.

Breadboard Connector on the Hub

Do not insert the leads of LEDs and other components directly into the Hub’s
Breadboard Connector. Assemble the components on the breadboard and use the
provided jumper cables to connect the breadboard to the Hub.

Do not connect the 5V receptacle pin on the Hub's Breadboard Connector to any of
the other pins, especially the ground pins. Doing so could damage the Hub.

Connecting the top row of receptacle pins (BB1-10) to the bottom row (grounding
and power pins) is not recommended.

No pin on the Hub's Breadboard Connector can sink or source greater than 4 mA.

Breadboard

Do not connect the positive and negative leads of a power source to the same
group of 5 pins on the breadboard. Doing so could damage the breadboard and the
power source.

Observe the correct polarity:
- When connecting the breadboard to the Hub.

- When connecting components that are sensitive to polarity, such as LEDS and
the TTL Power MOSFET.

1/0 Modules

Use the correct Input or Output port as required for each module.
- Vibration Motor — supported on OUT 1, OUT 2, and OUT 3.

- Servo Motor — use OUT 3 only.

- White LED — supported on OUT 1, OUT 2, and OUT 3.

- Analog Light Sensor — supported on IN 1, In 2, and IN 3.
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- Ultrasonic Ranger — supported onIN 1, IN 2, and IN 3.

Use an Auxiliary Power Source for modules that require more than 50 mA,
including:

- Vibration Motor

- Servo Motor

Do not hold the Servo Motor’s shaft while it is rotating. Also, do not rotate the
Servo Motor by hand.

White LED:

- Do not bend the leads repeatedly; this will weaken the wires and may cause
them to break.

- The LED requires the correct polarity when inserted into its socket. For details,
refer to the instructions for assembling the LED in the TI-Innovator™ eGuide

(page 2).
No I/0 module can sink or source greater than 4 mA.

32



General Information

Texas Instruments Support and Service

General Information: North and South America

Home Page: education.ti.com

KnowledgeBase and e-mail inquiries: education.ti.com/support

Phone: (800) TI-CARES / (800) 842-2737
For North and South America and U.S.
Territories

International contact information: education.ti.com/support/worldwide

For Technical Support

Knowledge Base and support by e-mail: education.ti.com/support or
ti-cares@ti.com
Phone: (866) 846-2844

For Product (Hardware) Service

Customers in the U.S., Canada, Mexico, and U.S. territories: Always contact Texas
Instruments Customer Support before returning a product for service.

For All Other Countries:
For general information

For more information about Tl products and services, contact Tl by e-mail or visit the
Tl Internet address.

E-mail inquiries: ti-cares@ti.com

Home Page: education.ti.com

Service and Warranty Information

For information about the length and terms of the warranty or about product service,

refer to the warranty statement enclosed with this product or contact your local Texas
Instruments retailer/distributor.
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